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Getting Started

To get started, make sure that you have installed Adobe InDesign version CS4, CS5, CS5.5 or CS6. You can down-
load and install the Kindle Plugin for Adobe InDesign® from this webpage. For detailed instructions about system 
requirements and installation steps, refer to the Help and Release Notes.

It is recommended that you install the latest version of Kindle Previewer from this webpage. Kindle Previewer is a 
tool that emulates how books display on Kindle devices and applications. Kindle Previewer makes it easy to pre-
view the layout of a book and make sure its text displays properly for any orientation or font size.

It is recommended that while reading this document, you should refer to both the PDF and Kindle versions simul-
taneously so that the differences in formatting and layout between the two can be easily observed.

Formatting Guidelines

The first thing that you must bear in mind while creating Kindle books with Adobe InDesign is the difference be-
tween layouts of the two formats. Adobe PDF and such formats that are usually used for printing books are fixed 
layout formats which means that the text, images and other content is placed at specific locations on a page. Each 
page also has a specific fixed size which ensures that after printing, the book will appear exactly as it does on your 
computer screen.

Kindle books on the other hand have a reflowable layout which makes them agnostic of the screen size on which 
they will be read. This ensures better reader experience across various devices and font sizes. Because of the reflow-
able nature of the content, pages in the traditional sense are not imposed upon Kindle books similar to the way an 
HTML page cannot be divided into constituent pages. So while you may see some content on different pages in an 
InDesign document, it may or may not appear so on a Kindle.

Text Guidelines

Normal Text

You should not use any special formatting such as non-default font size, bold or italicized style or im-
posed font color or background color for the normal text in a Kindle book. Such behavior tends to be reported by 
Kindle users as poor experience since it overrides the users’ default reading settings. You can still use such styling 
for selected parts of the text.

Text Effects

A number of popular text effects available in Adobe InDesign are supported in Kindle books. Some of them 
are as follows:

1.	 Bold
2.	 Italics
3.	 Underline
4.	 Strikethrough
5.	 Superscript
6.	 Subscript
7.	 ALL CAPS
8.	 All small caps

http://www.amazon.com/kindleformat/kindlepluginforadobeindesign
http://kindlegen.s3.amazonaws.com/KindlePluginForAdobeInDesign_HelpAndReleaseNotes.pdf
http://www.amazon.com/kindleformat/kindlepreviewer


9.	 Baseline shift
10.	 Drop shadow
11.	 Outer glow
12.	 Background color
13.	Custom fonts

The following effects are not supported:

1.	 Vertical scaling
2.	 Horizontal scaling 
3.	 Skewing

Paragraph Formatting

It is preferable to use different paragraph styles for different blocks of content based on the logical organization 
of the document. You may apply different formatting to these paragraph styles to ensure that the content appears 
as intended. Supported paragraph style formatting options include:

1.	 Left indent
2.	 First line indent
3.	 Right indent
4.	 Space before (above)
5.	 Space after (below)
6.	 Font size and style
7.	 Alignment

Under alignment, the options left, right, center and justify are supported. Justify alignment defaults to last 
line left aligned as do all other variations of justify alignment such as right justify, center justify and full justify. 

The align towards spine and align away from spine options default to left and right alignment respectively.

Due to the reflowable layout, any absolute spacing between two blocks of content will be ignored. You can con-
trol the spacing between two paragraphs with the space before and space after options, as demonstrated here. 
Spacing between this and the above paragraph has been increased by using both before and after spacing. 
 
 

Other ways of controlling the spacing between content includes inserting forced line break characters as in-
serted before this paragraph and enabling preserve forced line breaks check box during export. You can also insert 
paragraph returns as inserted after this paragraph and enable preserve consecutive white spaces and new lines 
check box. Each line break character/paragraph return will add an HTML newline tag during conversion.

Page Breaks

You can insert an explicit page break using the page break character. Inserting an even or odd page break char-
acter will also have the same effect. However, inserting multiple page breaks one after the other will still count as 
inserting a single page break.



You can also set up a paragraph style so that a page break is always inserted before the paragraph. A possible 
use of this option is in the case of chapter titles where you want each chapter to start on a new page. To set this up, 
navigate to the Keep Options page in the paragraph style dialog and select the Start Paragraph On Next Page op-
tion from the drop down list. Applying this paragraph style to the chapter title will ensure that each chapter starts 
on a new page.

White Space Characters

If you need to insert multiple consecutive space characters, you can use the Non-breaking Space character from 
the Type menu. You can also simply enter normal space from keyboard and enable ‘preserve consecutive white 
spaces and new lines’ check box during kindle export.  You should avoid using unicode format characters..

Custom Fonts

You can now embed various fonts in your book. These fonts may either be applied to text or used to add 
a special marker for bullets, as discussed later. You can use custom fonts to impart your Kindle book its own 
unique look and feel. You should ensure that you have the necessary permissions to embed and distribute any 
custom fonts that you use.

You should keep a tab on the size of the generated file since embedding a font will increase the file size. Typi-
cally, each font style for the same font will have its own font file and so using different font styles such as italics 
and bold will add a new font file. Avoid embedding a font that is only required for a particular bullet or some 
small text, unless absolutely necessary. Also, avoid adding common fonts like Times New Roman and Helvetica 
which are already available on the Kindle devices to avoid bloating of the Kindle file. Remember that a larger file 
will take longer to download for users and will also increase the delivery costs.

In the Kindle Export Options dialog, you can specify whether you want to embed all the fonts used in the docu-
ment, if you only want to embed the fonts required for bullet markers or if you don’t want to embed any fonts at 
all. If you perform a guided export, you will be prompted with another dialog during the conversion that displays 
all the fonts used in the document. You can select or deselect individual fonts and font styles in this dialog to suit 
your needs. These settings will be remembered for all subsequent conversions as well as for other documents so 
you can perform a quick export after you’ve set your preferences the first time.

Monospace Font

Apart from the default, Kindle also supports a monospace font which can be used by changing your text font 
to Courier. Below is an example piece of code formatted with the monospace font.

#include <iostream>
int main()
{
    std::cout << “Hello World!” << std::endl;
}

You can use the monospace font along with the non-breaking space character to ensure precise rendering of 
particular content such as code blocks.

Conditional Text

You can use the conditional text option in certain scenarios where you need two versions of some text with 
minor variations while the majority of the content remains the same. The sentence below gives an example of the 
use of conditional text. Refer to the InDesign file for the condition.



The Explorer is used to manage your files on Windows.

You can invoke the conditional text dialog from the Window menu under Type & Tables. You can create vari-
ous conditions and then tag the appropriate text with those conditions. Toggle the visibility of one or more condi-
tions to display your text correctly.

Text variables are not supported by the plugin as of now.

Special Characters

You must use special characters judiciously and with caution to avoid any conversion issues. Many special 
characters provided within Adobe InDesign such as • © … ¶ ® § ™ are supported in the text of the document. For 
the full list of supported characters, refer to the Kindle Charset Support section in the Amazon Kindle Publishing 
Guidelines.

However, you should avoid certain special characters in the Book Title or the Table of Contents title, which are 
entered in the Kindle Export Options dialog. You may use all the printable ASCII characters, which includes all the 
characters you can type using a standard PC or Mac keyboard. You should not use any other Unicode characters 
such as © or ® in the Book or TOC title.

You must exercise additional caution in the case of file and folder names. As far as possible, avoid any special 
characters, especially / \ : * ? “ # < > ~ % | in the names of files and folders. These include

1.	 Source InDesign document (INDD) or InDesign Book (INDB) file
2.	 All the individual InDesign documents included in an InDesign Book
3.	 Target Kindle (MOBI) file
4.	 Cover image file
5.	 Folder path containing the source files
6.	 Folder path containing the target file
7.	 Folder path containing cover image file

The plugin attempts to validate numerous inputs to filter out potentially problematic special characters. How-
ever, not all scenarios can be covered and so you may occasionally get a warning or error message during conver-
sion. Due to operating system limitations, these errors may sometimes get misinterpreted as being caused by lack 
of disk space or write permissions. In such cases, verify that you do not have any special characters in the above 
mentioned locations and try converting the document again.

Multiple Columns

Any content that appears in a multiple column lay-
out will be converted to single column layout by the 
plugin. This includes text and images as well. If you 
face any issues with the conversion of multicolumnar 
content, you should try to verify the ordering of the 
content in the columns. If the issues aren’t resolved, 
you can try to manually change the content layout to 
a single column and convert again. Although tables 

can be used to split content into multiple columns, it is 
not recommended in the case of Kindle books. Tables 
should only be used to display tabular data. If a table 
contains too many columns or too much text in a col-
umn, it might make the table significantly larger than 
the screen forcing the user to pan the table repeatedly 
leading to a poor reader experience.

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf


Tables

You can now format tables with a variety of options such as border weight, border styles and border stroke col-
ors. Paragraph formatting options such as alignment and margins and table formatting options such as space be-
fore and space after will also be honored. You can also specify background color for cells, alignment of text within 
cells and cell inset spacing. The formatting described here will not be retained in the Mobi format.

Recommended Dietary Allowance of Vitamin C
Adults (>19 years):

Males 90 mg
Females 75 mg

Infants / children:

0-6 months 40 mg
7-12 months 50 mg
1-3 years 15 mg
4-8 years 25 mg
9-13 years 45 mg
14-18 years (males) 75 mg
14-18 years (females) 65 mg

The Kindle format support nested tables. If you have a complex table with fancy borders or which uses very 
specific formatting, consider converting the table to an image. However, the limitation of using an image is that 
the user will not be able to pan across an image as it will be rendered on a single screen. In case of larger images 
with larger tables, you can split the images so that the contents of the table are legible. Refer to the Table Guidelines 
section of the Amazon Kindle Publishing Guidelines for more instructions on rendering tables.

Boxed Elements

Kindle plugin also supports boxed elements for displaying prominent information. To create a 
boxed element, add the text to a new text frame. Then select the text frame using the selection tool 
and set a border weight from the Tools menu. You can also set the border and background color using 
the Stroke and Fill color. Insets can also be set using Object>Text Frame options>Inset Spacing

You can also specify rounded corners for the boxed element from the Tools menu. You can 
choose a corner style and the corner radius to style the boxed element as per your needs. While all cor-
ner styles are not supported, the plugin will try and fall back to the closest corner style possible.

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf


Hyperlink Guidelines

External Hyperlinks

You can add links to external web pages from your documents by selecting some text and creating a new hyper-
link to the required URL. Hyperlinks will turn up as underlined clickable text in the converted file. On supported 
Kindle devices, clicking a hyperlink will bring up the web browser which will attempt to load the link provided 
there is an internet connection. On other reading applications such as Kindle for PC, Kindle for iPad etc., hyper-
links will open in the devices’ default web browser.

Cross-References

You can also add cross-references to locations within the same document. For instance, the following link adds 
a cross-reference to the beginning of the Text Guidelines section. To insert a cross-reference, you must first add a 
hyperlink destination of type Text Anchor to the location where you want to link to. Now you can insert a cross-
reference at the location that you want to link from and select the appropriate Text Anchor as the destination.

By default, all the links will appear in blue text color with an underline. But by exporting to kindle with ‘pre-
serve InDesign’s hyperlink styles’ checkbox enabled, you can carryover the character/paragraph styles along with 
local overrides applied to the links in the document.

Footnotes

You can insert footnotes1 simply by clicking Insert Footnotes from the Type menu. Positioning of the footnote 
in the converted file can be customized according to your requirements. By default, the plugin will attempt to posi-
tion footnotes before a forced page break. If you have set up a paragraph style to start on a new page as described 
above, footnotes will also be inserted at the end of the previous section before the page break.

You can change this default behavior in a couple of ways. The first way is to insert footnotes after paragraph, in 
which case, the footnotes will be inserted immediately after the paragraph containing the footnote reference. So 
for instance, the footnote in the previous paragraph will appear between the previous and this paragraph.

The other option is to insert all the footnotes at the end of the book. You should use this option if you have 
trouble getting the footnotes to appear in appropriate locations or if the footnotes interrupt the flow of text in the 
book. In this case, all the footnotes will collected together and inserted at the absolute end of the book. If you are 
converting from InDesign books (INDB), the footnotes from all the individual InDesign documents (INDD) will 
be aggregated and appended to the end of the book.

Note that the numbering style of the footnotes as specified in the Document Footnote Options will be ignored 
by the plugin. Any special characters or symbols used to mark footnotes will also be ignored. Instead, numbering 
of the footnotes will always start from 1 and will be reset every time footnotes are inserted at a new location. Most 
of the text styling within the footnotes will be retained in the converted file.

List Guidelines 

You can use both bulleted and numbered lists to represent enumerated data. Lists may be created in an ad hoc 
manner or by applying the List Style option in paragraph styles. The plugin will retain all the paragraph styles ap-
plied to list items such as margins and paragraph spacing. Now with KF8, you have numerous options to style your 
lists. The following list gives some examples of the types of bulleted lists that are supported by the plugin.

1	 This is an example of a footnote. Formatting is preserved within the footnote.

http://www.amazon.com/kindleformat
http://www.amazon.com/kindleformat


•	 A list item can have a simple bullet.
◊	 A special character can also be a bullet marker.
*	 This is a unicode character with a character style.
»» This is a bullet using a custom font and a character style.
ǷǷ OpenType glyph characters (salt, dlig, liga etc.) are not supported and will default to normal bullets.
өө For instance, this bullet marker has a glyph of type “ornm” which defaults to a normal bullet after export. 

The character style of the bullet is still retained.
ө…ө You can also specify text after for bullets, as with this list item.

Similarly, KF8 also adds support for a wide variety of numbered lists, as illustrated below.

1.	 This is a simple numbered list item.
ii.	 This item has a lower case Roman number format.
c.	 This item has an alphabet with a character style.
0004.  This item has multiple leading zeros.

0004.I.	 This is a nested list at level 2.
0004.II.	 You can customize the list number using a combination of the current and parent list levels.

0004.01.  This item goes one level deeper.
5.	 This list item comes back to the topmost level.

The numbering of lists will be picked up exactly as it is in the InDesign document. So you must ensure that all 
list items are correctly numbered. If your list is going to span multiple paragraphs, pages or documents, it is advis-
able that you create a new list from the Define Lists dialog under the Type menu. Now you can associate a list with 
the appropriate list item so that the numbering remains consistent. Avoid nesting lists that span multiple stories 
or documents.

The above list styles are not support in the Mobi format and will be replaced by simple bullets or numbers. Mar-
gins or indentation for lists will also not be supported. The numbers on the lists will still be maintained accurately. 
In the case of nested lists, deeper levels will get intended according to their level. To make sure that nested lists are 
exported correctly, you should always specify the list level wherever required, and not create nested lists with just 
the indents.

Drop Caps Guidelines 

KF8 allows you to have beautiful drop caps with custom embedded fonts in your Kindle books. The plugin al-
lows you to take advantage of this feature in a simple and straightforward way. You can add drop caps to your 

InDesign document either by specifying it in the paragraph style or by simply changing the Drop Cap number of 
lines and number of characters for a paragraph from the Character Formatting Controls. You can also apply char-
acter styles to the drop cap character directly from the controls or from the paragraph style.

Due to variations in metrics of various fonts, the same CSS may produce different results for drop caps us-
ing different fonts. To enable you to export all drop caps in the best possible manner, the plugin provides 
a dialog for customizing the CSS parameters for drop caps. This dialog, displayed during the export 

process, lists all the fonts  that have been used in the document for drop cap characters. So, for instance, the above 
paragraph has a 2 line drop cap using font Brush Script MT and this paragraph has a 3 line drop using font MV 
Boli. Fonts will be listed in the dialog only once, even if they are used in more instances.

The drop caps dialog allows you to configure various CSS parameters for your drop caps like margins and font-
size. The margins allow you to position the drop cap character relative to the text around it. A more negative top 
margin will raise the drop cap character while a positive top margin will push it lower. Similarly, if you find the 
drop cap overlapping over the text below it, add a more positive bottom margin. Or specify a more negative bottom 



margin if you find too much space below the drop cap character. Likewise, use the left and right margins to add or 
remove any space before or after the drop cap character.

The dialog also allows you to specify two font sizes for the drop cap character. The first font size multiplier, for 
KF8, should be modified if you find the drop cap character to be too small or large. The multiplier you specify is 
multiplied to the drop cap number of lines and added as the font size in em units. The second font size is for the 
Mobi format. Since Mobi format doesn’t support drop caps, you can specify a larger font size for the drop cap char-
acters to approximate the drop caps effect on the older readers.

Another thing to note is that the plugin remembers the values that you configured for a particular font, even 
across all the documents. So if you set up your drop caps to display perfectly for a particular font, you won’t need 
to repeat the effort again for subsequent conversions of that document or for other documents that use the same 
font for drop caps. Your custom CSS will also be applied if you perform a Quick Export. Avoid using drop caps in 
lists or footnotes.

Table of Contents Guidelines

The Kindle Plugin for Adobe Indesign now provides two options for adding a Table of Contents. You can either 
define and include an InDesign TOC or you can manually create a cross-referenced TOC and then link to it. Both 
the options are described below:

Including InDesign TOC

Creating a table of contents for Kindle books follows similar steps as creating a table of contents for InDesign 
documents. First you need to create a set of paragraph styles that will be applied to the text making up the TOC 
entries. Each level of TOC entries will have one or more paragraph styles associated with it. After applying the 



paragraph styles to section headings, you need to create a TOC style and include all the relevant paragraph styles. 
You can use the Table of Contents Styles dialog under the Layout menu to create TOC styles and define the level 
hierarchy for the TOC entries.

Once you define a TOC style, you do not actually need to create and place the TOC within the InDesign docu-
ment. When you choose a TOC style in the Kindle Export Options dialog, the plugin will create a TOC with all 
the entries that you intended to include and place the TOC at the beginning of the converted file. In the case of 
InDesign documents (INDD), you can specify another location for the TOC by creating and placing the TOC in 
the InDesign document. However, this option is not available for InDesign books (INDB) where the TOC will 
always appear at the beginning of the book.

You can refer to the source of this document for an example of the TOC conversion process. The table of con-
tents style TOC Style is comprised of three paragraph styles - Heading 1, Heading 2 and Heading 3 - at the first, 
second and third level respectively. Simply doing this and specifying TOC Style during export will add a TOC at 
the beginning of the book. Since we want more control over the location of the TOC, we create a TOC in the In-
Design file and place it after the title page and just before the contents start. This ensures that the TOC appears at 
the same position in the flow of the book.

If you place a TOC in the InDesign document, only the location within the content flow will be used during 
conversion. The actual text of the TOC along with any formatting etc. will be ignored. Instead, the text to which 
the TOC paragraph styles have been applied will be used to create the TOC. You can define TOC entry and title 
paragraph styles available in InDesign’s Table of Contents Styles dialog. You can specify a title for the TOC in the 
Kindle Export Options dialog. You also have the option of choosing from among four defined formatting options:

1.	 Flat layout means that all the TOC entries irrespective of the level will appear one below the other without 
any differentiating indentation.
2.	 Indented format will render the TOC entries in such a way that the indentation is proportional to the level 
of the TOC entry.
3.	 Numbered list will create a TOC in the form of a numbered list nested according to the levels.
4.	 Bulleted list will similarly create a bulleted list of TOC entries nested according to the corresponding levels.

In the case of InDesign books (INDB), you can select a TOC style from any of the documents added to the 
book. Once you select a particular document, plugin will list you out all the TOC styles defined in that document.

Linking custom TOC

If you are not satisfied with the quality of the TOC created with InDesign or if you would like to add some 
custom styling to the TOC, you also have the option to manually create a TOC and then link it from the export 
options dialog. You will need to manually create all the table of contents entries and then link each entry to the ap-
propriate location by cross-referencing. Finally, add a text anchor just before the heading of your TOC. The export 
options dialog will list all the text anchors in the document from which you can then choose the anchor which 
corresponds to your table of contents. It also lists all the hyperlink text sources and cross-references present in the 
document from which you have to choose the final TOC entry of your Table of Contents which is required for cor-
rect NCX generation. In case of InDesign books (INDB), all the included documents will be listed and all the text 
anchors and hyperlink text sources will be displayed for each file.

Note that you should not link to an InDesign TOC created using an InDesign TOC style and placed in the 
document in this manner. Also note that, NCX view will contain all hyperlinks and cross-references defined in 
between your Table of Contents anchor and the final TOC entry hyperlink.

To see an example of a table of contents linked in this way, refer to the source of this document. In the condi-



tional text dialog, you can find one condition each for an InDesign TOC placed in the document and for a manu-
ally created and cross-referenced TOC. You can toggle between visibility of the two conditions to view either of 
the two tables of contents. In the manually created TOC, a text anchor named “Table of Contents” has been added.  
Final TOC entry in this case would be “General Guidelines”. While exporting the document, you can choose to 
link a TOC and then select this text anchor to export the manually created TOC.

Image Guidelines

The Kindle platform supports GIF, BMP, JPEG, PNG images in your content. Vector graphics are not supported 
and should be converted to raster graphics using one of the supported image formats. The size limit for images is 
127KB. Below this limit, all images will be exported unaltered while above this limit, images will be automatically 
optimized to be under the size limit during conversion.

You can also take advantage of the optimization options that InDesign provides for images. In the Kindle Ex-
port Options dialog, you can choose to export either the original embedded images or the versions optimized by 
InDesign based on various parameters, as described below referenced from Adobe InDesign Help.

1.	 Formatted Preserves InDesign formatting, such as rotation or scale, as much as possible for web images.

2.	 Image Conversion Lets you choose whether the optimized images in your document are converted to GIF 
or JPEG. Choose Automatic to let InDesign decide which format to use in each instance.

3.	 GIF Options (Palette) Lets you control how InDesign handles colors when optimizing GIF files. The GIF 
format uses a limited color palette, which cannot exceed 256 colors. Choose Adaptive to create a palette using a 
representative sample of colors in the graphic without any dithering (mixing of small spots of colors to simulate 
additional colors). Choose Web to create a palette of web-safe colors that are a subset of Windows and Mac OS 
system colors. Choose System (Win) or System (Mac) to create a palette using the built‑in system color palette. 
This choice may cause unexpected results. Select Interlace to display a slowly loaded image gradually by fill-
ing in missing lines. If this option is not select, an image looks fuzzy and gradually becomes clear as the image 

http://help.adobe.com/en_US/indesign/cs/using/WS032BF3B3-6DF2-4544-9017-3AD3160F6C65a.html#WSC00B0206-F84C-4d08-92D8-A19C44FA8CB4a


reaches full resolution.

4.	 JPEG Options (Image Quality) Determines the trade-off between compression (for smaller file sizes) and 
image quality for each JPEG image created. Low produces the smallest file and lowest image quality.

5.	 JPEG Options (Format Method) Determines how quickly JPEG graphics display when the file containing 
the image is opened on the web. Choose Progressive to make the JPEG images display gradually and in increas-
ing detail as they are downloaded. (Files created with this option are slightly larger and require more RAM 
for viewing.) Choose Baseline to make each JPEG file display only after it has been completely downloaded; a 
placeholder appears in its place until the file displays.

The above options will be enabled if you choose to export optimized images. You can leave these parameters to 
their default values for a reasonable balance between image quality and file size or you can choose to tweak them 
to suit your requirements.

You should note that images may be further optimized by kindlegen during conversion even if you have speci-
fied an optimized format in the Kindle Export Options dialog. It is recommended that you always use the best 
quality images available, preferably in 300 dpi or 300 ppi resolution, and then let kindlegen optimize the images. 
Also, include color images wherever available to future proof your images and take advantage of the color displays 
on Kindle applications for other devices such as PC or iPad.

For images containing a lot of text, using the GIF format is recommended so 
that the sharpness and legibility of the text is retained. Since an image is always dis-
played completely on the screen, image resolution should be constrained to a maxi-
mum of 500x600 so that the image is not scaled, making it hard to read. Minimum 
font size should be such that a lower-case “a” is atleast 6 pixels tall. You can reduce 
the number of colors used in an image to optimize it’s size or split the image hori-
zontally to keep it under the size limit. It is highly recommended that automatic 
optimization by kindlegen be avoided in case of images containing text.

You can also insert images inline  with the text as displayed here. An image inserted inline with the text 
should not be considerably taller that the text lest it increases the spacing between consecutive lines. Images placed 
as floating objects outside a text box, like this image of a stack of books, may not appear to follow the same flow 
of content in the converted file. This is because the plugin processes blocks of content one at a time and a floating 
image is processed as a separate block than the text that surrounds it.

All Kindle books are required to have a cover image. You can specify a cover image in the Kindle Export Op-
tions dialog. The preferred format for the cover is a JPEG image of 600 x 800 pixels. Cover images less than 500 
pixels on the smaller side stand to be rejected. The content of your cover image should not infringe any other pub-
lisher’s or artist’s copyrights and should not mention any pricing or promotional details.

For more information on image optimization techniques, refer to the Image Guidelines section of Amazon 
Kindle Publishing Guidelines.

Metadata Guidelines

The Kindle Plugin for Adobe InDesign® allows you to add certain metadata information to the converted file. It 
extracts any metadata that you have added to the InDesign file and prefills this information in the Metadata panel 
of the export options dialog. In case of InDesign books (INDB), the information is retrieved from the File Info of 
the style source document. The follow metadata are supported as of now:

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf


1.	 Book Title: The title should match the content from the hardcover or paperback version and should not 
contain any detailed description of the book.
2.	 Author: Multiple authors should be separated by a semicolon. The convention to be followed for naming 
the author is
[Surname] [Suffix], [Given Name] [Initial]
For example: “Buckley Jr., William F.”

3.	 Publisher
4.	 Publication Date: The publication date is added to the exported file only if the publication year has been 
specified. Further, the date is added only if the month has been specified.
5.	 Description: It should describe the exact content being published in the Kindle edition and should not 
mention any pricing details. You can add a new line to the description by pressing Ctrl+Enter.
6.	 Language: Language metadata can be specified by selecting one of the languages listed in the drop down 
list.

General Guidelines

This section documents general tips for using the plugin that do not fall under any specific category.

1.	 Close Adobe InDesign before you install or uninstall the plugin. Crucial files needed by the plugin may not 
get copied correctly if you install the plugin while InDesign is running. Similarly, uninstalling the plugin while 
Indesign is running may leave behind certain artifacts leading to an incomplete removal of the plugin.

2.	 Avoid installation or uninstallation of the plugin over the network. It is recommended that you download 
the installer and run it from your local machine.

3.	 Also avoid conversion of documents located on a network share. Network latencies can significantly in-
crease the conversion time, especially for large books. An intermittent network outage can also lead to a failed 
conversion. Instead, copy the files to your local machine before attempting to convert them.

4.	 To set start reading location in KF8 file, insert a text anchor at desired location in InDesign document and 
choose the it from start reading location drop down in contents panel during the export.

5.	 Embedded objects of certain formats like PDF or PS are not supported by kindlegen and will cause an er-
ror during conversion. However, the file may convert successfully in some cases if you select the Optimized 
Images option in Kindle Export Options dialog. This is because InDesign will try and insert the thumbnails of 
the embedded objects instead of the original files.

6.	 The kindlegen output is displayed in a dialog after the conversion process completes, either unsuccessfully 
or with warnings. The warning icon indicates that the conversion was successful but kindlegen threw some 
warning(s) due to some constraint not being respected. The most common reason for this is not specifying a 
cover image or specifying an image with non-recommended proportions. In case of an error, you can look at 
the output to deduce the reason for failure and try again.

7.	 As of now, embedding of audio or video files is not supported by the plugin.

8.	 If you need to edit the source of a converted mobi file, you need to first extract the file using an archiving 
tool such 7-Zip. On a Mac, you can simply change the extension of the file to zip and then extract it using the 
default archiver. A directory containing the source files will be created. You can find all the HTML, CSS, OPF 
and NCX files along with the embedded images in the folder named OEBPS. You can now edit any of the files 
and create a new mobi provided you don’t break the syntax of any file and follow the constraints laid down in 
the Amazon Kindle Publishing Guidelines. This is not recommended unless you know HTML, XML and CSS 
and are comfortable using command line tools. You can convert the edited files by invoking kindlegen on the 
OPF file or by simply dragging the OPF onto Kindle Previewer..
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9.	 If you have any feedback, complaints or suggestions for the plugin, write back to us at kindle-publishing-
tools@amazon.com. Alternately, you can click the Send Feedback link on the Kindle Export Options dialog. 
It will open a new mail dialog in your default email client and fill up the To and Subject fields. It will also add 
some debug information about your system, specifically the OS name and version, version of Adobe InDesign, 
plugin version and locale. No personal information will be collected.

~~~ end ~~~
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